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Understanding Worksoft Analyze Installation
Understanding Worksoft Analyze Installation

In order to use Worksoft Analyze,™ you need to install the following two applications:
 Worksoft Management Studio™ - Registers database settings that you intend to use with Worksoft Analyze. 

If you already have Worksoft Management Studio already installed, you can use that version.
 Worksoft Analyze - Uses a shared repository approach for organizing and promoting collaboration in 

business process discovery and analysis among users in the enterprise.
Worksoft Analyze includes the Captures Listing screen that allows the user to view their captures, create 
documentation, and export documentation.

System Requirements
Before you begin to install Worksoft Analyze, verify that your environment has the needed system 
requirements installed. For information about system requirements and planning your environment, see the 
Worksoft Help Portal.

Port Requirements

Worksoft Analyze requires that you use the following ports when configuring the product:

Configuring Your Application Server

In order to transform your application server into a web server, Microsoft® Internet Information Services (IIS) 
must be installed in order to host Worksoft Web services and Worksoft web applications. After you have 
installed IIS, you will need to configure the Server Manager.
This chapter will guide you to configuring the minimum requirements for Worksoft Analyze. You may need 
assistance from your IT administrator.

Warning:
A new server must be provisioned for Worksoft Analyze only. Do not install Worksoft 
Analyze on the same server as other Worksoft products and other applications 
because of the constraint of bandwidth on the network interface controller 
(NIC card).

Component Port Number

Worksoft Application Server 80

Worksoft Application Server if using HTTPS 443
6 Worksoft Analyze Installation Guide
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Adding Roles and Features
Adding Roles and Features

The Server Manager allows you to add specific roles and features to your web server that are required for 
Worksoft products.

 To add roles and features to your web server:

1 From the Start menu, select Administrative Tools > Server Manager.
The Server Manager opens.

2 In the Navigation pane, select Dashboard.
3 In the Summary Tasks pane, select Add Roles and Features.

The Add Roles Wizard opens.

4 Click Next.
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Adding Roles and Features
The Select Installation Type page appears.

5 Select the Role-based or feature-based installation option.
6 Click Next.
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Adding Roles and Features
The Select Server Roles page appears.

7 From the Server Roles list, select the following roles:
• File Services
• Web Server (IIS)

8 Click Next.
After you have added the roles to the web server, you will add features to the web server.
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Adding Roles and Features
A dialog box appears asking if you want to add features to the web server.

9 In the Add Features dialog box, select the Include Management Tools (if applicable) option.
10 Click Add Features.

The Select Features page appears.
11 Select the .NET Framework 4.6 Features (Installed) and all of its child nodes.

12 Select the WCF Services (Installed) and all of its child nodes.
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Adding Roles and Features
13 Select IIS Hostable Web Core (Installed) and Media Foundation (Installed).

14 Verify that Message Queuing (1 of 7 installed) and Message Queuing Server (Installed) is 
enabled.

15 Use the scroll bar to verify the Windows Process Activation Service is enabled with the following 
child nodes:
• Process Model (Installed)
• Configuration APIs (Installed)

16 Click Next.
The Web Server Role (IIS) page appears.
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Configuring the Web Server Role (IIS)
Configuring the Web Server Role (IIS)

After you have added your roles and features, you will now need to configure the Web Server role (IIS) in the 
Server Manager.
1 Click Next on the Web Server Role (IIS) screen.

The Select Role Services page appears.
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Configuring the Web Server Role (IIS)
2 In the Role Services list, select the following services. You will need to use the scroll bar to select all of 
the services.

3 Click Next.
The Confirm Installation Selections page appears.

4 Click Install to install the role services.

Node Child Nodes

Common HTTP Features Default Document

Directory Browsing

HTTP Errors

Static Content

WebDAV - Verify that this option is disabled. Worksoft’s 
RESTful Services will not work correctly if enabled.

Health and Diagnostics HTTP Logging

Request Monitor

Performance Static Content Compression

Dynamic Content Compression

Security Request Filtering

Basic Authentication

Application Development .NET Extensibility 4.6

Application Initialization

ASP

ASP.NET 4.6

CGI

ISAPI Extensions

ISAPI Filters

WebSocket Protocol

Management Tools IIS Management Console

IIS Management Scripts and Tools

Management Service

IIS 6 Management Compatibility and the following 
child nodes:
• IIS 6 Metabase Compatibility
• IIS 6 Scripting Tools
• IIS 6 WMI Compatibility
Worksoft Analyze Installation Guide 13



Configuring Application/Json Mime-Type Compression
Configuring Application/Json Mime-Type Compression

After you have enabled dynamic content compression within IIS, you need to verify HTTP Compression for the 
application/json mime-type. Worksoft Analyze uses dynamic content compression to improve performance. 
In order to implement this performance improvement in Analyze, HTTP compression must be enabled for the 
application/json mime-type. When the Dynamic Content Compression feature is enabled, it will overwrite any 
previous HTTP compression settings. If the application/json mime-type was already included in the list of 
allowed dynamic mime-types before the Dynamic Content Compression feature is enabled, it will be removed. 

 To verify application/json mime-type compression:

1 Open IIS Manager.
2 In the left Navigation pane, click on your server. 
3 In the Management section, double-click the Configuration Editor.

The Configuration Editor opens.
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Configuring Application/Json Mime-Type Compression
4 From the Section drop-down list, select system.webServer > httpCompression.

5 In the httpCompression section, click the dynamicTypes.

6 Verify that application/json is listed in the dynamic compression mime types. If it is not listed, click 
the Add button in the Collection section to add it.
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Enabling IIS Services
7 After you completed your verification or addition, click the Close button
The Configuration Editor opens.

8 Click Apply to apply your changes.
9 Verify that dynamicTypes lists a count of six.
10 Close the editor.

Enabling IIS Services

You will now need to verify that several IIS services are enabled.

 To verify IIS services are enabled:

1 If the Server Manager is not open, select Administrative Tools > Server Manager from the 
Start menu.
The Server Manager opens.

2 In the Navigation pane, select IIS.
3 In the right Services pane, verify that the following services are enabled and running:

• Application Host Helper Service
• IIS Admin Service
• Windows Process Activation Service
• World Wide Web Publishing Service

4 If any of these window services are not running, you will need to start these services.
To start a service, select the service from the list and click Start in the right menu. You are also able to 
start your services by going to Administrative Tools > Services on your machine.
16 Worksoft Analyze Installation Guide



Chapter 2 Installing and Configuring Worksoft Analyze
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Worksoft Management Studio
Worksoft Management Studio

Before you begin to install Worksoft Analyze, you need to have Worksoft Management Studio installed. Go to 
the Worksoft Customer Portal to download Worksoft Management Studio. For specific system requirements 
and installation guide, see the Worksoft Help Portal.
If you have Worksoft Execution Suite installed, you can use that version of Worksoft Management Studio. 
Worksoft recommends that you use the remote Worksoft Management Studio instance for Worksoft Analyze if 
you are using it with Worksoft Execution Suite. For more information, see “Using a Remote Worksoft 
Management Studio Instance” on page 29.

Installing Worksoft Analyze

After you have installed the Worksoft Management Studio, you will now install Worksoft Analyze on your 
server.

 To install Worksoft Analyze:

1 In your software distribution folder, double-click the WorksoftAnalyze.exe file.
The Worksoft Analyze Install Wizard opens.

2 Click Next.
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Installing Worksoft Analyze
When the system analysis has completed, the Destination Folder page appears.

3 Accept the default installation folder path and click Next.
The Specify Hosted Configuration in IIS page appears.
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Installing Worksoft Analyze
4 If you want to accept Default Web Site as your web site, click Next.
If you have other webs configured in the IIS, select the server from the drop-down list and click Next.
The MongoDB Connection String page appears.

5 For Upgrading Only
If you are upgrading Worksoft Analyze, type in your database connection string in the MongoDB 
Connection String field and click Next.
Example: mongodb://username:password@servername/analyze
20 Worksoft Analyze Installation Guide



Installing Worksoft Analyze
The Starting Installation page appears.

6 Click Next.
The Worksoft Analyze Installation Completed page appears.

7 Click Finish to complete the installation.
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Adding Machine Keys
Adding Machine Keys

After you verify authentication, you need to add machine keys to the Analyze application and the 
Worksoft.Analyze.Api application in the IIS Manager.

 To add machine keys:

1 In the Connections Navigation pane of the IIS Manager, select the Analyze application.
2 In the ASP.NET section, double-click the Machine Key icon.

The Machine Key window opens.
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Configuring the SQL Server
3 Verify that the Validation key Automatically generate at runtime option is not selected.
4 Verify that the Decryption key Automatically generate at runtime option is not selected.
5 In the right Actions pane, click Generate Keys.

New Validation and Decryption keys are generated.
6 Copy these key values to a text editor, such as Notepad, to be used for Worksoft.Analyze.Api.
7 In the right Actions pane, click Apply.
8 For Worksoft.Analyze.Api, verify that the Validation and Decryption keys are not selected.
9 Delete the existing Validation and Decryption keys, and paste the newly generated Analyze keys into the 

correct key fields for the Worksoft.Analyze.Api application.
10 In the right Actions pane, click Apply.

You have now completed configuring Worksoft Analyze. 
11 Close the IIS Manager.

Note: All servers in a server farm or load balancer pool should have the same key values for both 
applications in the IIS Manager. You must copy the Validation key and Decryption key to all the 
machines in the pool.

Configuring the SQL Server

To use Worksoft Analyze, you will need to create and connect to the following two SQL Server databases:
 Analyze

This database contains activities and variants used to render and visualize your workspaces. You will 
create and update this database in Worksoft Management Studio. For more information, see “Registering 
and Creating a Worksoft Analyze Database” on page 38.

 AnalyzeSettings
This database is for data specific settings. You will need to manually configure the connection string and to 
run database configurations.

Be sure to verify that your SQL Server meets the system requirements listed in docs.worksoft.com.
You will also need to create a MongoDB database. For more information, see “Configuring the MongoDB 
Server” on page 25. The MongoDB database is used to store captures for display in the Captures List.
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Running Database Migrations
 To configure the connection string for the AnalyzeSettings:

Specify the SQL Server connection string to the database you'd like to use within C:\Program Files 
(x86)\Worksoft\Worksoft Analyze\Api\web.config.

SQL Server Connection String Example:

name must equal "AnalyzeDBConnection"
connectionString is unique to your environment and database server
providerName will differ based on database engine used:

for Microsoft SQL Server use providerName="System.Data.SqlClient"

for PostgreSQL use providerName="Npgsql"

databaseName = AnalyzeSettings

Running Database Migrations

Database migrations are used to initially create and update the database schema. Once the SQL Server 
connection string is configured, use the following command to update the database schema to the latest 
version.
If your credentials in the connection string gives you permission to create a new database, then the database 
does not need to exist before running migrations the first time.

Note: You must run the script on the server where Worksoft Analyze is installed.

 To run database migrations:

1 Open PowerShell or the Command Prompt and navigate to the following directory:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Api\bin

2 Run the following command:
migrate.exe Worksoft.Analyze.Api.Common.dll Worksoft.Analyze.Api.Common.Migrations.Configuration/
startUpConfigurationFile="..\web.config"

The database is created and/or updated.
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Configuring the MongoDB Server
Configuring the MongoDB Server

MongoDB should be installed on the server where Worksoft Analyze is installed. The MongoDB server stores 
Worksoft Capture processes that are imported by the Worksoft Analyze Automatic Generation Document 
feature. 

 To configure MongoDB server:

1 From the Start menu, run services.msc to open the Windows Services Manager.
2 Find the MongoDB service and enable the service.
3 Close the Services Manager.
4 Open the Windows File Manager and navigate to the following folder: 

C:\Program Files (x86)\Worksoft\Worksoft Analyze\Database.
5 Copy the configuremongo.bat and addanalyzeusers.js files and paste them to the MongoDB server 

in the following folder: 
C:\Program Files\MongoDB\Server\4.0\bin

The configuremongo.bat file creates the Analyze database and users.
The addanalyzeusers.js file provides the username and password configurations for the Analyze 
users.

6 Double-click the configuremongo.bat file to run it.
When you run the file, the following occurs:
• A database named Analyze is created.
• A collection named Captures in the Analyze database is created.
• An administrator user with read and write roles is created in the Analyze database.
• A user named analyzeuser with read and write roles is created in the Analyze database

7 Open the Services Manager window.
8 Stop the MongoDB service.
9 Go to the following directory:

C:\Program Files\MongoDB\Server\4.0\bin
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Configuring the MongoDB Server
10 Open the mongod.cfg file in Notepad to edit the settings.

If you want to bind to a single IP address, see the MongoDB reference guide.
11 Update the Security authorization setting to enabled.
12 Enable the MongoDB service.

Make note of the MongoDB connection string because it will be needed when running the Worksoft 
Analyze installer.
Example: mongodb://username:password@servername/analyze

13 Close the Services Manager.

Note: To connect to your MongoDB instance, use a product, such as Robo 3T.
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Configuring Worksoft Analyze Web API
Configuring Worksoft Analyze Web API

In order to connect with Worksoft Analyze Web API, you need to update the Web.config file in the following 
directory:

C:\Program Files(x86)\Worksoft\Worksoft Analyze\API\Web.config

 To update Worksoft Analyze Web API:

1 Open the Web.config file in the API folder in Notepad.
2 Replace the MgmtStudioServiceUrl value with the Worksoft Management Studio URL:

<add key="MgmtStudioServiceUrl" value="http://<server>/ManagementStudio/" /> 
<server> = Worksoft Management Studio URL.

3 Replace MongoUrl value with the MongoDB connection string:
<add key="MongoUrl" value="mongodb://analyzeUser:password@127.0.0.1:27017/analyze" />

4 In order to support email notifications, replace AnalyzeWebApp to the Worksoft Analyze URL:
<add key="AnalyzeWebApp" value="http://localhost/Analyze/" />
If Worksoft Analyze is configured behind a load balancer, and SQL server is being used for the settings, 
you need to change the EnableBackplane value.
If you do not have this configuration, go to Step 6.

5 Replace the EnableBackplane value to true.
<add key="EnableBackplane" value="true"/>

6 Save the configuration file and close it.
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Using HTTPS on Your Application Server
Using HTTPS on Your Application Server

In order to import generated Worksoft Analyze Captures into Certify, you need to use HTTPS on your 
application server and leave the HTTP binding on default port 80. After you have reconfigured the application 
server to use HTTPS, the port will now default to 443. You will need both ports open.
In order to use HTTPS on your application server, you will need to do the following:
 Request an SSL Certificate from your IT department.
 Add the certificate to IIS.
 Add new binding to port 443.
 Configure your database in the Worksoft Management Studio.
 Verify your SSL Settings on your application server.
Before you begin your configuration, verify that your application server has been set up and working with 
HTTP.

 To configure your database in the Worksoft Management Studio:

1 Open the Worksoft Management Studio on your web server by navigating to the following address: 
http://localhost/ManagementStudio.

2 Click the Master Configuration tab.

3 In the Management Studio URL field, change HTTP to HTTPS.
The URL address must match the address from the Issued To column in the Server Certificates window. 
Example: https://worksoftMSServer.worksoft.com/managementstudio

4 Click Save Changes.
5 Close the Worksoft Management Studio.
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Using HTTP on Your Application Server
 To verify your SSL Settings on your application server:

1 Open the IIS Manager on your application server.
2 In the IIS Connections pane, select Sites > Default Web Site > Management Studio.
3 In the middle pane, double-click SSL Settings.
4 Verify that the Require SSL option is not selected.
5 Go back to the IIS Connections pane, and select Sites > Default Web Site > SAPWebService.
6 In the middle pane, double-click SSL Settings.
7 Verify that the Require SSL option is not selected.
8 Close the IIS Manager.

Using HTTP on Your Application Server

Worksoft recommends that you use HTTPS on your application server. If you do not use HTTPS, then you will 
need to update the web.config file located in the following directory:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Web\web.config file

In the configuration file, find the line: 
<httpCookies httpOnlyCookies="true" requireSSL="true" sameSite="Strict" />

Change requireSSL="true" to requireSSL="false"
Example:
<httpCookies httpOnlyCookies="true" requireSSL="false" sameSite="Strict" />

Using a Remote Worksoft Management Studio Instance

If you are using a remote Worksoft Management Studio instance with Worksoft Analyze, you need to copy over 
the Analyze database folder to the machine where Management Studio is installed in order for it to create and 
update Analyze databases. The database folder is located in the following directory:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Database

Also, configuration files for the following components need to be updated in order for them to connect with the 
remote Management Studio instance:
 Worksoft Analyze Windows Service
 Worksoft Analyze web application
 Worksoft Analyze Web API
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Updating Worksoft Analyze Windows Service
Updating Worksoft Analyze Windows Service

By configuring the Worksoft Analyze Service configuration file, it will insure that the Worksoft Analyze Windows 
Service is able to connect and use the remote Management Studio instance. The configuration file is located in 
the following folder:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Service\
Worksoft.Analyze.Service.exe.config

Update the following application setting parameters:
 Replace the MgmtStudioServiceUrl value with the remote Worksoft Management Studio URL:

<add key="MgmtStudioServiceUrl" value="http://<server>/ManagementStudio/" /> 
<server> = Name of the Worksoft Application Server where Management Studio is installed.

 Replace the SecuritySvcOrProductCBUrl value.
The value of this setting is sent to Worksoft Management Studio, and it is used to call back to the Worksoft 
Analyze server to initiate a security handshake.
<add key="SecuritySvcOrProductCBUrl" value="net.tcp://localhost:4242/Analyze/
IAnalyzeSecurityCB" />

TCP Connection
If the server where Worksoft Management Studio is installed and it can connect with a TCP connection to 
the Worksoft Analyze server, then just replace localhost with the hostname or IP address of the 
Worksoft Analyze server.
HTTP or HTTPS Connection
If the server where Worksoft Management Studio is installed can only connect to the Worksoft Analyze 
server over HTTP or HTTPS, then change the value to 
http(s)://<analyzeservername>/Analyze/IAnalyzeSecurityCB

Do not set the port for the URL, as you would for Net.TCP. Specifying a port has the potential of causing 
issues with other services that may run on that port.

Verifying Settings

Open the log file C:\worksoft\logs\AnalyzeSvcLogFile.log on the Worksoft Analyze server and 
ensure no errors occur while starting Worksoft Analyze Windows Service.
Open the log C:\worksoft\logs\RegistrationService.log on the Management Studio server and 
ensure no errors occur during starting of the Windows Service.

Updating Worksoft Analyze Web Application

Update the Web.config file that is located in the following directory:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Web\Web.config

Replace the MgmtStudioServiceUrl value with the remote Worksoft Management Studio URL:
<add key="MgmtStudioServiceUrl" value="http://<server>/ManagementStudio/" /> 
<server> = Name of the Worksoft Application Server where Management Studio is installed.
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Configuring Worksoft Analyze Web API

In order to connect with Worksoft Analyze Web API, you need to update the Web.config file in the following 
directory:

C:\Program Files(x86)\Worksoft\Worksoft Analyze\API\Web.config

 To update Worksoft Analyze Web API:

1 Open the Web.config file in the API folder in Notepad.
2 Replace the MgmtStudioServiceUrl value with the remote Worksoft Management Studio URL:

<add key="MgmtStudioServiceUrl" value="http://<server>/ManagementStudio/" /> 
<server> = Worksoft Management Studio URL.

3 In order to support email notifications, replace AnalyzeWebApp to the Worksoft Analyze URL:
<add key="AnalyzeWebApp" value="http://localhost/Analyze/" />
If Worksoft Analyze is configured behind a load balancer, and SQL server is being used for the settings, 
you need to change the EnableBackplane value.
If you do not have this configuration, go to Step 6.

4 Replace the EnableBackplane value to true.
<add key="EnableBackplane" value="true"/>

5 Save the configuration file and close it.

Note: Depending on your environment, <server> may need to be specified as a fully qualified 
domain name (FQDN) instead of a simple server name. To ensure IP changes will not interfere 
with Analyze operations, do not replace <server> with an IP address.
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Overview
Overview

On your web server where IIS is installed, you will need to configure your system in the Worksoft Management 
Studio. The Worksoft Application Server installed the Worksoft Management Studio.
Within the Worksoft Management Studio, you will need to do the following Management Studio configuration 
tasks:

 Create a Worksoft Management Studio database

 Create and register a Worksoft Analyze database
 Add Worksoft licenses

 Register users

 Configure email service

The Management Studio database maintains configuration information used by Worksoft applications and 
services. Worksoft Analyze leverages information from the Worksoft Management Studio.

Exploring Worksoft Management Studio

Worksoft Management Studio consists of the following navigation tabs:

Navigation Tab Description

User Administration Register users and roles for each product.

Master Configuration Create the following databases:
• Management Studio
• Execution Manager
• Impact
• Analyze
• BPP
Configure the following:
• SMTP settings
• Maintenance window text
• Tenant administration

Configuration • LDAP Configuration
• Execution Manager
• Impact
• Certify Configuration - Add your Certify databases.
• Bookmark Administration - Execution Manager feature
• Licenses
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When you open Worksoft Management Studio, you will be able to see what part of your configuration requires 
attention by visual indicators.

Listed below are the visual indicators:
1. A red X means that there is either mandatory missing information or a failure with the current 

configuration. Each tab provides diagnostic information that will explain what failed and how to resolve 
the failure.

2. An animated circle means a diagnostic test is being performed to see if the configuration is complete and 
functional. If the test is successful, the circle will disappear, and if not successful, a red X will show a 
failure.

3. An exclamation mark means that there is an optional configuration that is available. No configuration has 
been made in these tabs, and you may want to configure these options in the future.

Integration Configure your connections with the following products:
• ALM integration
• Analyze connections
• Certify/Analyze integration
• SAP systems
• Panaya integration

Change History Display change history.

Navigation Tab Description
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Creating Your Worksoft Management Studio Database

The Management Studio database maintains configuration information used by Worksoft applications 
and services. Worksoft Analyze leverages information from the Worksoft Management Studio.
Only one Management Studio database is needed. If you have already created a Management Studio 
database, go to “Registering and Creating a Worksoft Analyze Database” on page 38.

 To create the Worksoft Management Studio database:

1 Open the Worksoft Management Studio on your web server by navigating to the following address: 
http://localhost/ManagementStudio.
The Management Studio Installation page opens.

2 Type in the Worksoft Management Studio URL address.
If you did not use the default website during installation, your URL address will be different. The 
implementation of your network landscape will need to be considered when choosing a URL address. 
Verify that the URL can be accessed by all users.
The URL address should either be a domain or a machine name for on-premise installations. If using a 
machine name, you will need to decide if a fully-qualified domain and machine name is required. Do not 
use IP addresses.
If your DNS settings require a fully-qualified machine name complete with domain, please make those 
changes accordingly.
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If their is a load balancer in front of one or more web servers, then the URL address should point to the 
load balancer domain. If you have any questions about your specific URL address, please ask your 
IT administrator.
If you intend to use HTTPS for your application server, you will need to first configure your server with 
HTTP, and then you will be able to reconfigure the application server to use HTTPS.

3 In the Management Studio Database section, type in the server name in the SQL Server field.
4 For SQL Database Authentication, type the SQL user name and password in the fields to access the 

database server.
The user name and password must have enough SQL Server permissions to create a database. After 
you created your database, you are able to use a different SQL user name and password.

5 In the Database Name field, type in the name of the Management Studio database.
Worksoft recommends using the database name ManagementStudio for easy identification.

6 Click the Test Configuration button to test your connection.
If the test fails, the reason for the database connection failure appears.
After it detects that the database does not exist, a Create button appears.

7 Click the Create button to create a new database.
If you are upgrading your database, then you will click the Update button.
After creating the database, your SQL Server database administrator should review the database 
settings and configuration so that it meets expectations and adheres to appropriate best practices, such 
as using an appropriate recovery model.

8 Click Continue.
After saving the Management Studio configuration, you will be prompted to log on to the Management 
Studio.

9 If you are a new user, type admin@worksoft.com in the User Name field.
10 If you are a new user, type password in the password field.
11 Click Login.

After applying this configuration, you have successfully enabled Management Studio to be operational.
The User Administration tab opens.
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12 Click the Master Configuration tab.

13 If you want to enable verbose logging, select the Enable Verbose Logging option in the Management 
Studio Options section and click Save Changes.
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Registering and Creating a Worksoft Analyze Database

Besides creating a Worksoft Management Studio database, you must create and register a Worksoft Analyze 
database.

 To create and register a Worksoft Analyze database:

1 In the Worksoft Management Studio, click the Master Configuration > Analyze tab.
The Analyze Database tab opens.

2 In the SQL Server field, type in the name of your SQL Server.
3 In the SQL User and Password fields, type in the SQL Server user name and password.

The user name and password must have enough SQL Server permissions to create a database. After 
you created your database, you are able to use a different SQL user name and password.

4 In the Database Name field, type in a unique name for your database.
Worksoft recommends using the database name Analyze for easy identification.

5 Click the Test Configuration button to test the connection.
If the test fails, the reason for the database connection failure appears.
After it detects that the database does not exist, a Create button appears.
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6 Click the Create button to create a new database.
If you are upgrading your database, then you will click the Update button.
After creating the database, your SQL Server database administrator should review the database 
settings and configuration so that it meets expectations and adheres to appropriate best practices, such 
as using an appropriate recovery model.

7 Click Save Changes to save your registered Analyze database.
8 Scroll down the Worksoft Analyze tab to verify that the services are running.

It may take a few minutes for the Worksoft Analyze Service to recognize this configuration change after 
you save the database.

Adding Worksoft Analyze Licenses

The administrator must upload their Worksoft Analyze licenses into the Worksoft Management Studio where 
they will maintain the licenses. Worksoft Customer Support provides you with license files. Save the license 
files to a directory that you will be able to access when adding them to the Worksoft Management Studio.

 To add Worksoft Analyze licenses to Worksoft Management Studio:

1 In the Worksoft Management Studio, click the Configuration > Licenses tab.
The Licenses tab opens.

2 Click Add.
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The Add License dialog box appears.

3 Click Choose File.
4 Browse to the directory where your license file is saved.
5 Click Open.

The license file name appears in the License File text box.
6 Click Add.

The new license appears in the Licenses tab.
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Registering Users

The next step to configuring Worksoft Management Studio is to register users who will be using the Worksoft 
Analyze.
There are two ways to register users:
 Manually add users in Worksoft Management Studio
 Import users from a Microsoft Excel® spreadsheet
If you have multiple tenants, users are added to the tenant in which you are logged into Worksoft 
Management Studio.

 To manually add users in Worksoft Management Studio:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Add.

The Add User dialog box opens.
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3 To create an active user, verify that Active is selected.
To deactivate a user, select Inactive.

4 In the related fields, type in the following information:
• First name
• Last name
• Email address
• Password
• Confirm Password

5 From the Authentication drop-down list, use the default authentication option Worksoft.
6 If you want to give the user administrative rights, select the Administrator option.
7 If you want the user to only be able to upload Worksoft Capture files, select Upload Only.
8 Select Analyze under User Roles.
9 From the Default Time Zone drop-down list, select a time zone for the user.
10 Click Add.

The user name appears in the left User Administration tab.

11 Repeat this process to add more users.

To edit a user, click the Edit icon next to the user.
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 To register users by importing from a Microsoft Excel spreadsheet:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Import.

The Import User dialog box opens.

3 To download an Excel template, click Download Sample Upload File.
Use this template to create your own Excel spreadsheet.

4 Click the Choose File button and select the CSV file that you want to import.
5 After you have selected your file, click the Import button.

The users are imported into the Worksoft Management Studio and appear in the Users Administration 
tab.
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Configuring Email Service

To send out Worksoft Analyze email notifications, you must specify the SMTP server that will send out email 
notifications.

 To configure your email service:

1 In the Worksoft Management Studio, click the Master Configuration tab.
The Master Configuration tab opens.

2 Scroll down to the SMTP Configuration section.

3 In the SMTP Configuration section, type in the following information:
• From Email
• SMTP Host
• SMTP Port
• SMTP User Name
• SMTP Password
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4 If you want to use a SSL certificate, select the Use SSL option.
5 If you are using tenant spaces and want to use the Master Configuration SMTP configuration, select the 

Offers to Tenant Spaces option.
6 Click the Test Configuration button to test your connection.

If the test fails, the reason for the failure appears in the Status section.
If the settings are not valid, Worksoft Analyze will still be functional; however, the size of your log file 
will be affected since Worksoft Analyze will log errors for all of the failed email notifications.

Accessing Worksoft Analyze

To access Worksoft Analyze, go to the following site to log onto the system:
http://<server>/Analyze
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Overview
Overview

When Worksoft Management Studio is installed, a single primary tenant is created by default, and this tenant 
is responsible for configuring the master configuration. From the primary tenant space, an administrator can 
create other tenant spaces if they want to partition data within their organization.
The administrator manages all tenants within Management Studio and assigns users to each tenant. These 
users will be managed by administrators in that tenant space.
Only users within the assigned tenant will be able view and access the data for that tenant. Captured process 
data that is uploaded into Worksoft Analyze will be associated to the tenant of the user performing the upload. 
Users associated with other tenants will not see the captured data.

Adding Tenants

Administrators add tenants in the Tenant Administration tab within the Worksoft Management Studio.

 To add tenants:

1 Log on to Worksoft Management Studio as an administrator.
2 Under Master Configuration, click the Tenant Administration tab.

The Tenant Administration tab opens.
3 Click Add to create a new tenant.

The Add Tenant dialog box opens.

4 To create an active tenant, verify that Active is selected.
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5 In the related fields, type in the following information:
• Tenant name
• Email address
• First name
• Last name
• Website address
• Phone number
The user that you specify will be the main administrator for this new tenant space. The default password 
for the administrator is password.

6 If you want to limit the number of users, clear the No user limit option and type in the number of 
users.
If you do not want to limit the number of users, leave this option selected.

7 From the Default Time Zone drop-down list, select a time zone for the user.
8 Click Add.

The new tenant appears in the Tenant Administration tab.
9 Log out of Worksoft Management Studio by clicking the arrow in the right-hand corner and selecting 

Logout.
10 Log on to Worksoft Management Studio with the email address you specified when creating the tenant 

and the default password.
You will now be able to perform administration tasks for the newly created tenant.

11 Repeat this process for creating additional tenants.
When creating additional tenants, an email account can be associated with more than one tenant space.

Switching Between Tenants

To switch between tenants, the administrator must log out of the Worksoft Management Studio. When logging 
on to Management Studio, the administrator must select a tenant from the Tenant list.
As long as the passwords for the tenant administrators are the same, then they will be able to select tenants 
from the Tenant list. If the password for either administrator is changed, then the user will not see the Tenant 
list and will only be able to manage the tenant in which it was created.
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Adding Users to Tenants

You will now add users to your multiple tenants by one of the following methods:
 Manually add users in Worksoft Management Studio
 Import users from a Microsoft Excel® spreadsheet

 To manually add users to tenants:

1 Log on to Worksoft Management Studio as the tenant administrator.
2 From the Tenant list, select the tenant in which you would like to create a new Analyze user.
3 In the Worksoft Management Studio, click the User Administration tab.
4 In the User Administration tab, click Add.

The Add User dialog box opens.

5 To create an active user, verify that Active is selected.
To deactivate a user, select Inactive.
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6 In the related fields, type in the following information:
• First name
• Last name
• Email address
• Password
• Confirm Password

7 From the Authentication drop-down list, use the default authentication option Worksoft.
8 If you want to give the user administrative rights, select the Administrator option.
9 If you want the user to only be able to upload Worksoft Capture files, select Upload Only.
10 Select Analyze under User Roles.
11 From the Default Time Zone drop-down list, select a time zone for the user.
12 Click Add.

The user name appears in the left User Administration tab.
13 Repeat this process to add more users.

To edit a user, click the Edit icon next to the user.

 To add users by importing from a Microsoft Excel spreadsheet:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Import.

The Import User dialog box opens.
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3 To download an Excel template, click Download Sample Upload File.
Use this template to create your own Excel spreadsheet.

4 Click the Choose File button and select the CSV file that you want to import.
5 After you have selected your file, click the Import button.

The users are imported into the Worksoft Management Studio and appear in the Users Administration 
tab.
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Updating Worksoft Analyze

To update Worksoft Analyze, you will run the installer from the distribution package.
If you are using a remote Worksoft Management Studio instance with Worksoft Analyze, you need to copy over 
the Analyze database folder to the machine where Management Studio is installed in order for it to create and 
update Analyze databases. The database folder is located in the following directory:
C:\Program Files (x86)\Worksoft\Worksoft Analyze\Database

 To update Worksoft Analyze:

1 Follow the instructions from the Worksoft Analyze upgrade distribution package.
The installer will uninstall the older version and then install the new version of the application.

2 After the installation completes, log on to Worksoft Management Studio to update the Worksoft Analyze 
database.
The Analyze tab displays a red X. Your database needs to be updated to sync with the new version.

3 In the Worksoft Management Studio, click the Master Configuration tab.
4 Click the Analyze tab.

The Analyze tab opens.
5 Click the Update button to update the database.

A message appears asking if you want to update the Worksoft Analyze database.
6 Click Update.
7 Repeat this process if you have more than one database.
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Appendix A Worksoft Analyze Silent Installation

Silent Install

To run Worksoft Analyze installation silently, run the installer from the command line and add /s option to the 
executable: 
WorksoftAnalyze.exe /s

Installation Log File

The default installation log is located at %userprofile% of the user who installed Worksoft Analyze. If you 
want to override the install log file location, enter the following string to provide an override for install log file 
location:
WorksoftAnalyze.exe /s /l=C:\temp\AnalyzeInstalllog.txt

Silent Uninstall

To uninstall Worksoft Analyze silently, run the installer from the command line and enter the following string:
WorksoftAnalyze.exe /s MODIFY=FALSE REMOVE=TRUE UNINSTALL=YES
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